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Preface

The purpose of this manual is to provide you with the information you need to use the
latest enhancements to the Panel List window in the iCare (BQI) population
management application.

This manual contains reference information about iCare views, examples of its
processes, and step-by-step procedures to show you how to perform activities related
to the Panel Definition window in the latest version of the iCare application.

For more information about iCare basic functionality, iCare usage, or training for
iCare, you may consult these resources:

iCare — IHS OIT
Available at http://www.ihs.qgov/icare/

iCare Population Management GUI, User Manual Version 2.2 (July 2011).
Available at http://www.ihs.gov/RPMS/PackageDocs/bqi/bgi_022u.pdf

iCare Training
Available at
http://www.ihs.gov/icare/index.cfm?module=dsp icare cmet training

Recorded AdobeConnect sessions for iCare
Available at https://ihs.adobeconnect.com/r6yazmozlgm

Join the iCare listserv by sending an e-mail to icare@listserv.ihs.gov

Panel List User Manual Preface
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1.0

1.1

1.2

Introduction

iCare is a Windows-based, client-server graphical user interface (GUI) to the IHS
Resource and Patient Management System (RPMS). iCare retrieves key patient
information from various components of the RPMS database and brings it together
under a single, user-friendly interface. iCare is intended to help providers manage the
care of their patients. The ability to create multiple panels of patients with common
characteristics (e.g., age, diagnosis, community) allows users to personalize the way
they view patient data.

The information included in this Panel List manual covers Panel List functionality in
iCare Version 2.4. For more information about iCare basic functionality, iCare usage,
or training for iCare, you can consult the resources listed above in the Preface.

Background

Along with the rest of the healthcare industry, IHS has already developed a set of
chronic condition management (or register) applications, including for diabetes,
asthma, and HIV. This type of application provides a way for healthcare providers to
manage a specific group (register) of patients for a single disease state. Register
management applications assist healthcare providers to identify high-risk patients,
proactively track care reminders and health status of individuals or populations,
provide more standardized and appropriate care by embedding evidence-based
guidelines, and report outcomes.

Many patients, however, have more than one diagnosed disease. For instance, at the
current time within the Indian Health system, a diabetic asthmatic woman could be a
member of four RPMS registers (diabetes, asthma, women’s health, and
immunizations). This “silo’ approach to patient care could potentially result in
fragmented care, and could increase the risk of inadequate patient care management
due to misidentification of the true level of risk.

ICare Graphical User Interface

The iCare GUI is intended to allow providers to see a more complete view of patients
with multiple conditions, while maintaining the integrity of the user-defined, disease-
specific registers.

iCare can help IHS providers by:

e Proactively identifying and managing different groups (populations) of patients
who share user-defined characteristics.

e Providing an integrated view of a patient’s conditions that would minimize “stove
piped” care management.

Panel List User Manual Introduction
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Providing an intuitive and integrated interface to the diverse patient data elements
of the RPMS database.

Facilitating providers a review of clinical quality of care measures for their own
patients to enable improvement in the quality of healthcare delivery.

Enabling views of traditional healthcare information from the perspectives of
community, population and public health.

Providing the default tag selection as Proposed and Accepted. You can change the
tag selection for any record by selecting or de-selecting any checkbox.

Clicking the “use AND?” check box when there are multiple tags selected. The
“And” option searches for patients who have ALL of the user-defined tags.

1.3 Who Should Use iCare?

Any provider who needs to identify a group of patients for long-term management or
to create a temporary list should think about using iCare. Do you fit any of the
following scenarios?

I am a nurse at a facility that assigns a primary care provider to each patient.
Every day, | want to create a list of scheduled patients for two different doctors in
my clinic.

I want to identify which of my patients are considered obese so | can recommend
nutrition counseling.

Because providers at our clinic have performance goals related to annual GPRA
clinical measures, | want to identify which of my patients are missing key clinical
data.

Our Women’s Health Clinic wants to focus on two clinical performance
improvement initiatives this year. We want to identify the performance problem
areas for female patients between the ages of 18 and 50.

I am one of two part-time case managers for a group of children, and | want to
create a patient list that we both can use.

I am a site manager working to ensure our site meets Meaningful Use objectives.

1.4 Features Introduced in Version 2.4
iCare Version 2.4 is composed of three different builds/packages:

ICARE MANAGEMENT SYSTEM 2.4
CARE MANAGEMENT EVENT TRACKING 1.1
HIV MANAGEMENT SYSTEM 2.2

Panel List User Manual Introduction
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The majority of changes in this release are to update the three parts of iCare to
incorporate ICD-10.

141 ICD-10 Updates

1.4.1.1 Update Glossaries and Help Files
The iCare application displays several glossaries, listed below, to describe and
document the criteria used by the nightly and weekly jobs to perform the data analysis
for the various data displayed in iCare. The displays are dependent on taxonomies and
therefore, the taxonomy updates documented above will require the following
glossaries to reflect those changes.
e Best Practice Prompts Glossary
e Care Management — Asthma Glossary
e Care Management — COPD
e Care Management — Diabetes
e Care Management — HIV/AIDS Glossary
e Community Alerts Glossary
e Diagnostic Tags Glossary
e |PC Glossary
e iCare Online Help

1.4.1.2 Community Alerts Update
The iCare application displays Community Alerts which are identified by the nightly
background jobs. The Community Alerts criteria depend on new and updated
taxonomies. The ICD-10 conversion will require that the Community Alerts logic be
validated with the updated taxonomies and the documentation of the logic visible in
iCare via glossary and help to reflect those changes. For those Community Alerts
without an associated taxonomy, a new taxonomy will be created with both ICD-9
and ICD-10 codes rather than relying on checking individual codes.

1.4.1.3 Diagnostic Tags Update
The iCare application displays Diagnostic Tags which are identified by the nightly
and weekly background jobs. The Diagnostic Tag criteria depend on taxonomies
updated to include ICD-10 codes. The ICD-10 conversion will require that the
Diagnostic Tag logic be validated with the updated taxonomies and the
documentation of the logic visible in iCare via glossary and help will need to reflect
those changes. Diagnostic Tags update will affect Diagnostic Tag views in panels and
patient records.
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1.4.1.4 Family History Update

The iCare application displays Family History data in the Patient Record. The ability
to add/edit/delete Family History conditions has been disabled.

1.4.1.5 Problem List Update

The iCare application displays Problem List data in the Patient Record. The ability to
add/edit/delete Problems has been disabled.

1.41.6 PCC Procedures Update

The iCare application displays PCC Procedure data in the Patient Record. PCC
Procedures include a field for a procedure code based on the ICD-9 procedure code
set. The ICD-10 conversion will require an update to the display of the PCC
procedure in iCare be updated to show the appropriate ICD code.

1.4.1.7 Taxonomy Update

The iCare application displays taxonomies and their respective entries. A new way of
displaying taxonomies has been implemented. The ICD-10 conversion will require
that the display of taxonomy entries be updated to allow for ICD-10 codes to be
included. This will include a new column indicating which code is ICD-9 and which
code is ICD-10.

Additionally, the dialog will be updated to improve usability and display other
associated fields like matches at your facility to the associated LOINC code and NDC
code.

Further, the ability to view the SNOMED subsets defined for IPL will be included.

1.4.2 Non ICD-10 Updates

1.4.2.1 Patient Demographics
Two new fields were added to Patient demographics list:

e Last Immunization Notification
e Last Reminder Notification
This will list the last notification created for the patient.

1.4.2.2 Care Mgmt Group

A new Care Mgmt Group has been added for Prenatal patient care. It is composed of
the following columns:

Panel List User Manual Introduction
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e Currently Pregnant? - Marked as “yes” in the Reproductive factors file
e Estimated Delivery Date - The definitive EDD from Reproductive Factors
e Estimated Gestational Age - The EGA measurement from V Measurement

e High Risk - If the patient has any active prenatal problems that are marked as high
priority, show the provider narrative(s).

Additionally, a new lab test taxonomy was created called BQI PRENATAL TAX.
You may populate this taxonomy with the lab tests that you want to see for your
prenatal population. Each lab test will display as a column and show the RESULT
(DATE).

Note: After updating this taxonomy, the iCare Nightly Job must
run to do the update.

Panel List User Manual Introduction
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2.0 Panel List View

The Panel List view displays a list of your current panels, including the default panel,
the panels created by the user, and the panels shared with you by other users.

Panel List | Flag List Community Alerts Nat'| Measures | CMET = Meaningful Use | IPC

NN TN
Mew Open Delete | Repopulste | Modify Share Copy Category
¥ =7 Category 5 Panel Name 5  Panel Description ~ #of Pts 7 Last Updated W LlastUpdated By v Owner i J: i
CR 4470 986 Apr 01, 2015 03:57 PM
HIVIAIDS Dx Tag 5 Jul 02, 2014 01:31 PM
Infants 29 Mar 11, 2015 01:10 PM

99 Apr 07, 2015 02:08 PM
0 Apr 23, 2015 03:07 AM
Pregnant 0 Apr 17, 2015 07:56 AM
Sched Appts 0 Jul 02,2014 01:38 PM

in Peach Springs 20-35 yrs

Mammogram reminders

Figure 2-1: Sample Panel List view

The Startup View tab on User Preferences determines the view that will display when
you first login to iCare.

To view the Panel List window, do one of the following:

e If you are in Split View, the Panel List will be in the left frame.
e If you are not in Split View, you need to click the Panel List tab.

e If you are in another window, select the iCare Main option from the Window
menu.

Panel List User Manual Panel List View
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3.0

Panel List Layout

Panel List | Flag List Community Alerts Nat'| Measures | CMET & Meaningful Use | IPC
o & & | £ | F R G
Mew Open Delete | Repopulste | Modify Share Copy Category

¥ =7 Category 5 Panel Name 5  Panel Description ~ #of Pts 7 Last Updated W LlastUpdated By v Owner i n;;’: i
CR 4470 986 Apr 01, 2015 03:57 PM
HIV/AIDS Dx Tag 5 Jul 02, 2014 01:31 PM
Infants 29 Mar 11, 2015 01:10 PM
Mammogram reminders in Peach Springs 20-35 yrs 99: Apr 07, 2015 02:08 PM
» 0 Apr 23, 2015 03:07 AM
! " Pregnant i 0 Lpr 17, 2015 07:56 AM
Sched Appts 0 Jul 02. 2014 01:38 PM

Figure 3-1: Sample Panel List layout
The Panel List has the following data columns:

Flag: the Flag Indicator (*) icon displays in the first column if one or more patients
in any of the panels have any flags.

Panel Name: user-defined name of the panel (required). Hover help for this field
displays the properties of the panel.

Panel Description: user-defined description of the panel.
# of Pts: the number of patients in the panel.

Last Updated: the date and time the contents of the panel was last updated by a
manual (user) repopulate, by an auto-repopulate, or the panel created date, if the panel
has never been repopulated.

Last Updated By: the name of user who either created or last repopulated the panel.
Owner: the name of the user who created (“owns”) the panel.

Shared With: this column has different icons representing whether a panel has been
shared by you with other user or shared with you by a user.

You can view how your patient panel is shared by hovering your mouse over the last
column of the panel.

! |

Shared with:
ADAM,ADEM [R] (Apr 16, 2007 - Apr 23, 2007)

Figure 3-2: Sample Shared With Information
The icons in the Shared With column have the following meanings:

The [ icon means you have Read/Write access to the panel.

Panel List
June 2015
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The k icon means you created the panel and have shared it with other users.
The &1 icon means you have read-only access to the panel.

You can sort and/or filter any column, re-arrange the order of the columns, etc.

Panel List User Manual Panel List Layout
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4.0

4.1

4.2

Panel List Toolbar

The toolbar buttons and menu options determine what actions can be taken on this
window.

New

Use the New function to create a new panel. You can create a patient panel in one of
the following ways:

e Clicking the New (|__N;1w_|) button

e Selecting the New option on the context menu
e Selecting File | Panel | New

e Pressing the key combination of Ctrl+N

Any of the above actions displays a blank Panel Definition window where you can
create a new panel.

Open

Use the Open function to show the patients in one or more selected panels. Highlight
the panels by holding down the Ctrl key and then use the Open function.

You can open selected panels by doing one of the following:

e Clicking the Open (;‘;1“.) button

e Selecting File | Panel | Open

e Selecting the Open option on the context menu
e Double-clicking on the panel

e Pressing the Ctrl+O key combination

e Selecting File | Recent Panels and selecting the panel name (the list is limited to
the last five panels that you have viewed)

A Panel View window displays for each of the selected panels, showing the patients
for the panel.

More than one user can open a shared panel simultaneously. The second and
subsequent users to open the same panel will have “read only” access to the panel
content. If the first user closes the panel, the second user will be notified that the
panel is now available for “edit” access, unless the user only has been provided with
Shared Read Only access by the panel creator.

Panel List User Manual Panel List Toolbar
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4.3

43.1

Delete

You can delete the selected panels that are no longer useful. There are two conditions
for the delete function: (1) when you delete a panel you created and (2) when you
delete a panel that was shared with you.

Delete Panel You Created

You can delete a panel that you created. Highlight one or more panels by holding
down the Ctrl key and then using the Delete function.

You can delete the selected panels by doing one of the following:

B

i,
e Clicking the Delete (leskte]) button

e Selecting File | Panel | Delete
e Selecting the Delete option on the context menu
e Pressing the Delete key on your keyboard

The “Confirm panel delete” dialog displays, asking if you want to delete the selected
panels. Click Yes to delete the panels. Their names will no longer appear in the Panel
List view. (Otherwise, click No.)

Shared users with shared access to the deleted panel will receive notification that you
(the person who deleted the panel) are no longer sharing the panel.

Panel List User Manual Panel List Toolbar
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EE iCare Motifications ﬁ
File Edit Tock
= & v 23 M3 G

Delets Select All

T Notification Text T Body v

: You have been added as a shared user for !
: Panel Mammogram reminders by

3 Apr21, 20150653 4V SN ‘'ou have been deleted from sharing panel
Mammaogram reminders for&
Apr 20, 201509:16 AM I ou have been added as a shared user for
Panel Mammogram reminders by

Apr20, 20150913 AM NN . have been deleted from sharing panel

m

a Mammaogram reminders for

Apr20, 20150251 AM N ‘vcou have been added as a shared user for
a Fanel Mamﬁram reminders by
o Apr20,201508:49 AM I rou have been deleted from sharing panel

Mammogram reminders for

Apr07, 20150212 PV N ou have been added a5 & shared user for
Panel Mammogram reminders by

Mar 30, 2015 11:20 AM CRS Updated The RPMS Clinical Reporting System (CRS)
has been updated on your facility's server.
This update may affect your iCare Natl
Measures view, because of new or
inactivated performance measures. Please
review your Natl Measures layout and
templates and update as nesded. -

Selected Rows: 1 Visible Rows: 9 Total Rows:

-]

Figure 4-1: Sample iCare Notification for Deleting a Shared Panel

If you are in the Delete Process and you clicked Yes and the selected panel is open in
another window, the following message will display:

x

Panel “new pks™ is open.
Please close the panel bafore delating it

B i
Figure 4-2: Warning Message About Panel Open in Another Window

Click OK to dismiss the warning and focus returns to the Panel List window. In
order to delete the panel, you need to close it and then use the Delete process.

4.3.2 Delete Panel Shared with You

If you delete a panel that was shared with you, you will no longer see the panel on
your list, i.e., the shared access is deleted but the panel remains for the panel creator
and other shared users.

Panel List User Manual Panel List Toolbar
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4.4

Repopulate

Use the Repopulate function when the patients in a selected panel need to be updated
with new data (for example, some patients have moved). Repopulate reruns the panel
definition against the cached data (from the nightly job) where it adds patients who
meet the criteria and removes the patients that no longer meet the criteria.

You can repopulate the highlighted panel by doing one of the following:

2]
e Clicking the Repopulate (|Repspudate [) button

e Selecting File | Panel | Repopulate
e Selecting the Repopulate option on the context menu

e Setting the Auto Repopulate Options under the panel modifications (use the
Modify button)

The Repopulate Panel warning message displays asking if you want to update the
patient list for the panel. Click Yes to repopulate the patient list. (Otherwise, click
No.) This message does not appear for Auto Repopulate.

The repopulate process (cannot be undone) will run as a background operation.

The “clock” icon will appear to the left of the panel name while the process takes
place; the date and time of the Last Updated column will be updated.

Community &lerts MNat'| Measures CMET | Meaningful Use | IPC

= T
Modify  Share Copy Cstegory

Panel List | Flag List

O & =

Mew Open Delete

£

Repopulste

W Category < Panel Name < Panel Description " #Hof Pts 7 Last Updated i
1 986 Apr 01, 2015 03:57 PM

"HIVIAIDS Dx Tag
Infants

Mammogram reminders

Patients Assigned To Demo

Pregnant
Sched Appts

5 Jul 02, 2014 01:31 PM
29 Mar 11, 2015 01:10 PM
99 Apr 07, 2015 02:08 PM
0 Apr 23, 2015 03:07 AM
0 Apr 17, 2015 07:56 AM
0 Jul 02, 2014 01:38 PM

in Peach Springs 20-35 yrs

Figure 4-3: Example of Panel List during Repopulate Process

4.4.1

Other Warning Message

If you manually edited (added or removed) patients in the panel, the Maintain
Manual Changes warning message will display.

Panel List User Manual
June 2015
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4.4.2

4.4.3

Maintain Manual Changes = Ej

This panel has been edbed manually (patients added or removed), Do vou want bo keep your manual changes whils repopulating?
! Answer Yes IF you want to keep the manually addad or removed patients.
Answer o' if you want the patient st repopulsted.

[ ¥es | Mo | Concel

RE

Figure 4-4: Maintain Manual Changes Warning Message
Click Cancel to exit the Repopulate function for the selected panel.

Click No if you want the patient list totally refreshed. In this case, any added patient
names will be lost as well as any deleted patient names will be added back to the
panel.

Click Yes if you want to preserve the manually added and removed patients. The
“Background populate?” information message displays asking if you want to
repopulate in the background. Click Yes if you want the repopulation to execute in
the background. Otherwise, click No to repopulate in the foreground.

This process does not run for panels that are manually populated. If you try to run the
repopulate process in this situation, the application displays a warning message that
states: Panel is manually selected and cannot be repopulated. Please open the panel
and add or remove patients as necessary. Click OK to dismiss the message.

Panel Open in Another Window

If you are in the Repopulate Process and you clicked Yes and the selected panel is
open in another window, the following warning message will display:

RPMS iCare x|

Panel is currenthy open in another window.
! Flease repopidake from that window or
diose the panel and retry from the Panel List,

Figure 4-5: Warning Message about panel open in another window

Click OK to dismiss the warning and you exit the repopulate process.

Repopulate Not Active

You will not be able to repopulate a panel if your shared access is read-only. In this
case:

e The Repopulate button will be inactive

e The Repopulate option on the context menu will be inactive

Panel List User Manual Panel List Toolbar
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e The Repopulate option on File | Panel will be inactive

4.5 Modify
Use the Modify function to change the panel definition for a selected panel.
You can modify a highlighted panel by doing one of the following:
e Clicking the Modify (| ™ediy]) button
e Selecting File | Panel | Modify
e Selecting the Modify option on the context menu
If the selected panel is already open, a message about the panel being already open
displays.
RPMSiCare x|
Paniel "PM disbetic pts over 40 is already cpen.
Click OF ko activate this window.
Figure 4-6: Panel Already Open Message
Click OK and you move to the panel described in the message. You will modify the
panel from this window.
When you select the Modify process, the Panel Definition window displays,
showing the population criteria.
Panel List User Manual Panel List Toolbar
June 2015
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85 RPMS iCare - Sharing Reminders Notification - Panel Definition SRACE X
Definition r Layouts r Sharing r Auto Repopulate Options ]
“Panel Name: ‘Sharing Reminders Notification Category: | aa! Designate IPC Panel? [
Panel Descriphion: ‘Check onlssue 47
Population Search Options R
Mo Predefined Population & Fi
Search - Add Patients | B Fllter_s
manually j Patient o~
My Patients ~ Sex: |MALE - (¥ By Age Age: |grEaterthar| or equal to j 70 ‘YRS j
X " By DDB  Date of Birth: o
Patients Assigned to .
Preferred Communication Method - Preferred Language: -
Scheduled Appts .
~
Inpatient Visits ﬂ P (s
ER Visits - _+| Category (Living)
QMan Template L ﬂ ‘Community (None)
RPMS Register ~ ﬂ Diagnestic Tag (Mone) |
ﬂ Allergies (Mone) T
EHR Personal List -
ﬂ Employer (None)
Ad Hoc Search = ﬂ Ethnicity (None)
ﬂ Race (None)
_+|PCC (None)
_+| Problem (None)
_—| Reminder
Reminder: |DIABETES SCREENING (HS) j
(¢ Overdue 1 Due  Range
{* By Date to
" By Timeframe -
0K Cancel

4.6

Figure 4-7: Sample Panel Definition window to modify
Below is an overview of the tabs on this window:

Definition: used to specify the panel’s name and description as well as what criteria
to use to populate the panel.

Layouts: used to do two things: (1) select the layout for the “layout in use” for the
Patient List, Reminders, Natl Measures, Care Mgmt groups, and CMET on the panel
view tab and (2) the definition details for the defaults for the allergies, CPT, ER,
inpatient, labs, medications, patient education, problems, and reminders on the panel
view tab.

Sharing: used to share your panel with RPMS users.

Auto Repopulate Options: used to have your panel automatically refreshed.

Share

Use the Share function to define RPMS users who can share your panel.

You can share a highlighted panel by doing one of the following:

=
e Clicking the Share (lsharel) button
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e Selecting File | Panel | Share
e Selecting the Share option on the context menu
You will not be able to share a panel if your Share access is read-only. In this case:

e The Share button will be inactive
e The Share option on File | Panel will be inactive
e The Share option on the context menu will be inactive

After accessing the Share function, the Panel List window opens to the Sharing tab
on the Panel Definition window.

o5 RPMS iCare - Patients Assigned To Demo - Panel Definition = | B S
Definition rLayDuts/VSIlaring ]/ Auto Repopulate Options
Shared with: | ~|
Shared Access: * Read Only  Read/Write (" Inactive
™ Temporary?
I~ Share Layouts?
Apply Remove ) ==
Username Shared Access Start Date End Date Share Layouts?
p {ADAM ADAM AW 1]
Selected Rows: 0 Visible Rows: 0 Total Rows: 0
OK Cancel

Figure 4-8: Sample Sharing tab on Panel Definition window

When the Sharing tab is complete, click OK to save the Sharing information about
the particular panel. (Otherwise, click Cancel.)

4.6.1 Fields on Sharing Tab
Shared with: Your selection from the drop-down list is the person with whom you
want to share your panel.
Shared Access: The radio buttons become active after you populate the Shared with
field.
Panel List User Manual Panel List Toolbar
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Shaedwit:  [BDPROVIDER PAULD z
Shated Access: ™ ReadOn © ReadMiite © Inactive

[ Temporan?

[T Share Lapouts?

Figure 4-9: Sample Shared With and access rights

e Read Only: use this radio button to allow the person sharing your panel to only
view your panel. The shared user can change the layout of the panel.

e Read/Write: use this radio button to allow the person sharing your panel to view
and change your panel (for example, add or delete patients).

e Inactive: use this radio button to assign the person sharing your panel inactive
access rights.

Temporary: Select the Temporary check box to display a date range for the
temporary status of the shared user. The access rights will only apply during the
specified data range and will automatically expire once the specified date range has
passed.

¥ Temporans® Start Date: 7/ 32006 =] EndDate 10/ 4/2006 =

Figure 4-10: Sample Temporary status
You must select a date range when using the Temporary status.

Shared Layouts?: Select the Shared Layouts? check box if you want to share the
layouts of one or more of three panel views: Patient List, Reminders, and/or National
Measures. The shared user will see the same layout modifications made by the
creator.

e This causes the Shared Layouts cell (in the grid) to contain Y (for yes).

e The shared user will continue to be able to make modifications to the layouts of
that shared panel. These modifications will not affect the creator’s layouts.

4.6.2  Grid on Sharing Tab
The grid shows a history of the users (that have not been removed/deleted) with
whom you have shared the current panel.
Panel List User Manual Panel List Toolbar
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I I | TEREE
fuﬂ-mu | Shaied fietest | St Diate 'Erd Date | Shars Lapouts?
¢ | BDFRIVIDE R PalL D R M
| GPROVIDER ANGELINE ] U

Figure 4-11: Shared user information in lower grid

Add: click this button to add the information in the Shared with, Shared Access,
Temporary, and Shared Layouts fields to the grid.

Apply: click this button to change the Shared Access and/or Temporary status of a
selected user in the grid. You can change the shared access rights; for example,
change the access rights from Read Only to Read/Write.

Example: Highlight a user in the grid. The current access right (Read Only,
Red/Write, Inactive) shows in the Shared Access area. Assume you want to
change the selected user’s Read Only access right to Read/Write. Select the
Read/Write radio button. Then click the Apply button to reflect the changes to the
user in the grid.

Remove: highlight one or more names in the grid and click this button to remove the
name(s) from the grid. It might be more useful to inactivate the user instead of
removing the user. After clicking the Remove button, the “Delete Row” information
message displays, asking if you want to delete the selected names. Click Yes to delete
(otherwise, click No).

4.7 Copy
Use the Copy function to create a new panel by copying one of your existing panels
and saving it with a new name. What is copied is the patient population and the panel
definition along with any added or deleted patients.
You can copy a highlighted panel by doing one of the following:
&)
e Clicking the Copy (=) button
e Selecting File | Panel | Copy
e Selecting the Copy option on the context menu
Panel List User Manual Panel List Toolbar
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The Copy Panel dialog displays.

I=TE
M Parel Mane:
[y of new piin P
Copy Lapouts? v
| 1.4 | Cancel I

4

Figure 4-12: Sample Copy Panel Dialog
The default name displays in the “Panel Name” field. You can edit the name.
The “Panel Name” Free Text field contains a context menu for editing the text.

The Copy Layouts check box determines if the layouts of the columns are in the copy
process. The default is checked. If this field is not checked, the system default is used.

Click OK to have the “new” panel added to the Panel List view. (Otherwise, click
Cancel.)

Once copied, you can modify the panel in any way, such as changing the panel
definition, adding and deleting the patient names, etc.

If the entered name is a duplicate name, the “Panel Name is unique, please choose
another name” warning message displays. Click OK to dismiss the message and you
return to the Copy Panel dialog.

4.8 Category

Use the Category function to establish the category color for a selected panel.

e Clicking the Category (cﬂ:#v) button

e Selecting File | Panel | Category

e Selecting the Category option on the context menu
The Category Pick dialog displays.
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Figure 4-13: Category Picker dialog

Use the controls at the bottom as follows:
e Highlight a record in the grid and click Select to cause that color and name to
display in the Category field on the Panel List window.

e Highlight a record in the grid and click Clear to cause that color to be
removed by the Category field on the Panel List window. The Clear
Category option on the context menu or on File | Panel does the same thing.

e Click Exit when the dialog is complete.

New

Click New to create a new category color and name. The application displays the
New Category dialog.

=1o] x|
Category:
M arn: ]
e [T
oK Cancel

Figure 4-14: New Category dialog
Type the name of the new category in the “Name” Free Text field.
Click the down-down list for Color and pick a color to represent the new category.

When the dialog is complete, click OK and the new category will appear in the grid
on the Category Picker dialog. (Otherwise, click Cancel.)

Panel List
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Edit
Select a record in the grid on the Category Picker dialog and click Edit to
display the Edit Category dialog. See “New” above to edit either field.

Delete

Select a record in the grid on the Category Picker dialog and click Delete to
remove the record from the Category Picker dialog (there is no confirmation).

Panel List User Manual Panel List Toolbar
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5.0 Panel List Menus
The File, Tools, and View menus for the panel list window are reviewed below.
5.1 File Menu
Below are the options on the File menu.
Fie |Edt View Tools Window Hely
Fanel r
A ' Change RPMS ServerfLogin
Change RPMS Division...
Recent Panets ¥
Page Setup. ..
| Prink Preview
4 Print
5 Background Jobs
Exil; iCara
Figure 5-1: File Menu options
Panel: The sub-menus contain the actions that you can take on this window. For
example, the Properties option will display Panel Properties pop-up that provides
information about the panel such as the panel name, update history, shared users, and
flag types. The Properties option is also available on the context menu.
Change RPMS Server/Login: This option allows you to change the server
information and your access and verify codes to the iCare application on the iCare
2.4Login dialog.
Change RPMS Division: This option allows you to change the RPMS Division on
the Select Division dialog. This option applies to a site that uses more than one RPMS
database.
Recent Panels: This sub-menu shows your recent panels that you accessed. If you
select one, you can view the patients in the selected panel in a new window. The list
of panels is the last five panels that you have viewed.
Page Setup: This option allows you to set Margin, Paper, Layout characteristics (like
landscape or portrait orientation), and the Printer to use. These settings are used when
you use the Print option.
Print Preview: This option displays the print preview dialog.
Print: This option sends the information about the selected rows in the grid to the
printer using the settings in Page Setup.
Panel List User Manual Panel List Menus
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Background Jobs: This option displays the Background Jobs pop-up. This pop-up
displays, for example, the start and end dates for the nightly and weekly background
jobs.

Exit iCare: The option allows you to leave the iCare application. You will be
reminded to save any changed panels (if needed).

Lock iCare: This option locks the iCare application by displaying the “iCare locked
by user” dialog. You can do two things on this dialog:

e Resume working on the iCare application by entering your verify code and then
clicking Resume.

e Logout of the iCare application by clicking Logout.

5.2 Tools Menu
Below are the options on the Tools menu.
[Tools | Window Help
W Quick Patisnt Search, .. F&
W) Reset View
{[#] Refresh =
| 34 search Ctri+F
[E] Excel Export Ctr+E
=4 Print Crrl+p
44 Copy Rows to Cipboard Crie-shift+C
1 Manage Templates
S User Preferences
11| ¥iew iCare Notifications...
iCare Package Mansger [
iCare Ske Parameters s
Taxononmy Maintenance L2
Web Links *
Figure 5-2: Tools menu options
Quick Patient Search: This option searches for a patient name. This is the same as
using the F8 key on your keyboard.
The Reset View, Search, Refresh, Excel Export, Print, and Copy Rows to
Clipboard options work like the buttons on the right side of the window.
Manage Templates: This option allows you to manage the templates for various
parts of the application. Select this option to access the Template Management
dialog. Section 6.11 provides information about managing templates.
Panel List User Manual Panel List Menus
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5.3

User Preferences: This option opens the User Preferences window.

View iCare Notifications: This option opens the iCare Notifications pop-up that
provides information about various notifications that have been sent.

iCare Package Manager: This option is active for those users with Package Manager
security key. Section 6.5 provides information about the iCare Package Manager
Functions.

iCare Site Parameters: This option access several iCare site parameters.

iCare Sike Parameters 3 Employers

Taxonomy Mantenanos L4 Pregnancy

Wb Lirks * Inactivity Time Out

Reset Lisar CMET Ske Parameters

View iCare Log IPC Site Parameters
ML Site Paramebers
Dihvisions

Figure 5-3: iCare Site Parameters options

The options provide dialogs where you can establish the various parameters. Section
6.10 provides information the iCare Site Parameter options.

Taxonomy Maintenance: This option is used by those users who can maintain
taxonomies. Also, you use this option to view the taxonomy elements. This option has
the following two features:

View/Edit Taxonomy Entries: this feature displays the iCare Taxonomy View/Edit
dialog. Section 6.6 provides information about the iCare Taxonomy function.

Taxonomy User Access: this feature is active for those user with the proper security
key. Selecting this option displays the iCare Taxonomy User Access Management

Web Links: This option provides links to Web sites for related clinical guidelines.

View Menu

The View menu on the iCare Main window provides a way to change between the
Split View and tab view. If the Split View option is selected, a Refresh option is also
displayed.

Yiew | Tools ‘Window

Split Wiew

ﬂ Refrash FS

Figure 5-4: Sample View Menu
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Split View: Select Split View to have the current view in the split view with Panel
List in the left pane and the other tabs in the right pane. You can change to the Panel
List view by removing the checkmark; this is a temporary setting. When you exit
iCare and reopen iCare, the settings set under User Preferences for the default screen
are used.

Refresh: Use this option to update any RPMS field values on the current window
with new data from the server. This is the same using the F5 key on your keyboard.
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6.0 iCare Features Used by Panel List
The following provides information about using the iCare features for the Panel List
view.
6.1 User Preferences
This section focuses on the user preferences that are used by the Panel List window.
. a-! RAPMS iCare - User Preferences - E@i_hj
i Define My Patientsér Flag Setup r Comm Ale; Setup r Startup Viev: r Patient View r Panel View rLayouts rCMEI' r Meaningful Use IPC
Selact the definifion that besf desciibes your patisnt assignment NOTE: Many users do not have patienis assigned fo them and will chooss
Wo Frovider Sefected”. This will nof negativaly afect your ability fo fully vse the iCare application.
™ Mo Provider Selected
Provider Type
[DEMO DOCTOR ~| ¥ prcp
™ Specialty Provider Spacialty
Type:
I Edit
Min & of iaits in Timeframe
™ Primary Visit Provider
[ Primary/Secondary \isit Provider
OK [ cancel
Figure 6-1: Sample User Preferences window
After the User Preferences window is complete, click OK and the user preferences
will be in effect for the operation of the iCare application. (Otherwise, click Cancel.)
Startup View Tab
The selection on Startup View tab determines the tab that displays when you first
access the iCare application.
Panel List User Manual iCare Features Used by Panel List
June 2015

26



iCare Population Management GUI (BQI) Version 2.4

6.2

- el e

Define My Patients r Flag Setup r Comm Alert Setup}ﬁtartup\ﬂew

a5l RPMS iCare - User Praferances

Patient View r Panel View rLaynuts rCMEF r Meaningful Use IPC

Salect the startup view you would [ike fo ses when opaning iCars

% Panel List

" Flag List

" Community Alerts
" National Measures
" IPC

" CMET

" Meaningful Use
i Split View

" Panel View

oK [ cancel

Figure 6-2: Sample Startup View tab on User Preferences

Select the Panel List radio button if you want the Panel List to be the first window to
display when you access the iCare application.

Panel Properties

You can view the properties of a highlighted panel by selecting File | Panel |
Properties (or by selecting the Properties option on the context menu). The Panel
Properties pop-up displays. Click OK to dismiss the pop-up.
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ol RPMS iCare - HIV/AIDS Dix Tag - Panel Properties - _— Lﬁ

alr Update Histary r Shared/&ccess r Flag Setup l

Panel Mame: HIWVIAIDS Dx Tag
Created: 7/2/2014 1:31:54 PM By I
Panel Description:

Panel Definition (system generated):

Patients who are Living;
Diagnostic Tag HIVA/AIDS;
Panel Category: N/A IPC Panel: No;

Figure 6-3: Sample Panel Properties Pop-up

The General tab provides information about the panel name, when the panel was
created and who created it, the panel description, and any filters used to create the
panel.

The Update History tab provides information about the auto repopulate status,
when the panel definition was last modified and who modified it, when the patient
list was last populated and who modified it, and when the patient list was
manually updated.

The Shared/Access tab provides information about the shared users for the
current panel and their access rights.

The Flag Setup tab provides information about the timeframes for the flag types
(defined in User Preferences).

6.3 Free Text Fields
Free text fields are those fields that you can type information into; those types of
fields do not have a drop-down list from which to select an option to populate it.
An example of the free text field is the Panel Name field (when creating/editing a
panel definition).
There is a context menu to aid in editing the text.
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Cuk

Copy
Paste
Dahete

Salect all

Figure 6-4: Context menu to aid in editing text
These options operate just like those in any Windows application.
Undo: removes the last edit action.

Cut: removes the selected text from its current position and places it on the Windows
clipboard.

Copy: copies the selected text and places it on the Windows clipboard (the text is
NOT removed).

Paste: copies the contents of the Windows clipboard and places it in the field at the
current cursor position.

Delete: removes the selected text from its current position.

Select All: highlights all of the text in the current field.

6.4 Print Preview
The Print Preview window contains several features about reviewing and printing the
current document.
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Figure 6-5: Sample Print Preview dialog

The Print Preview window contains two panels, where the left panel displays the
pages in the document and the right panel displays a larger version of the page
selected in the left panel.

The following table provides information about the various buttons on the Print
Preview window.

Button Description
3 Used to output the contents of the document.
Also available by selecting Print option on the File menu.
m Used to move the red rectangular box on the selected page in the left panel.
: As you move the Hand Tool, this changes the display in the right panel. This

is used to view information in a particular part of a page.
Also available by selecting the Hand Tool option on the Tools menu.

ol Used to get a screen capture of a specified rectangular area. This screen
= capture copies the area to the Windows clipboard. Then you can paste the
copy in a particular field, for example, or another application like MS Word.

Also available by selecting the Snapshot Tools option on the Tools menu.

o Used to specify the zoom magnification. Click the button and then move to
= the area where you want to apply to zoom. Right-click on the area and select
the zoom magnification option from the context menu.

Also available by selecting the Dynamic Zoom Tool option on the Tools
menu.
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Button Description
@ Used to zoom out by clicking the button in an area in the right panel (the
- image becomes smaller).
Also available by selecting the Zoom Out option on the View menu.
@ Used to zoom in by clicking the button in an area in the right panel (the image
- becomes larger).
Also available by selecting the Zoom In option on the View menu.
Used to cause the image in the right panel to display to its maximum page
width (usually enlarges the image).
Also available by selecting the Page Width option on the View menu.
Used to cause the image in the right panel to display the image with no page
margins showing.
Also available by selecting the Margin Width option on the View menu.
Used to display the image and its page margins in the right panel.
Also available by selecting the Whole Page option on the View menu.
- Used to automatically cause the image in the right panel to zoom out (you do
& not click in the panel).
Also available by selecting the Zoom Out on the View menu.
N Used to automatically cause the image in the right panel to zoom in (you do
& not click in the panel).
Also available by selecting the Zoom In on the View menu.
L Used to cause all of the pages to display in the right panel.
r Also available by selecting the Continuous option on the View menu.
o Used to specify the page layout.
=

You move through the pages in the document by using the arrow buttons on the
second line in the toolbar.

1 ¥ ¥ -
= -

Figure 6-6: Buttons used to move through the pages of the document

The same options are available by selecting View | Go To (and on the context menu
for the right panel).

Use the Zoom ** % T field (or select the Zoom option on the View menu)

to specify the zoom magnification for the right panel by selecting from the drop-down
list.

Use the Close button to close the Print Preview dialog. This same action is available
by selecting File | Exit.

Select File | Page Setup to access the Page Setup dialog.
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Page setwp 2| x|

Papes

Size:

AoUnGe: | Automaticaly Select =]
Onentation Margins (inches)

™ Portait et [0.75 Right [075
* | andscape Top.  [0.75 Bottoen: (0,75

0K | Concel | Printec. |

Figure 6-7: Sample Page Setup dialog

Use the Page group box to specify the paper size and source.
Use the Orientation group box to specify the orientation of the output.
Use the Margins group box to specify the various margins widths in inches.

Click Printer to access the Printer dialog where you choose the printer to output the
contents of the document.

After the Page Setup dialog is complete, click OK to save the page setup options.
(Otherwise, click Cancel.)

6.5 iICare Package Manager Functions

When you have the Package Manager security key, you can access the functions by
selecting Tools | iCare Package Manager on the iCare main window.

iCare Package Manager P | 8 icare User Access Management
Resssign Panels

Figure 6-8: iCare Package Manager Functions
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6.5.1 iCare User Access Management
The iCare User Access Management option accesses iCare User Access Management

dialog.
When this dialog is complete, click OK to save your changes. (Otherwise, click
Cancel.)
o-! iCare User Access Managemant =HNE X
@ Help
EE{)gl'?dtiSngEditor Y iCwe " /Y Package ¥ Fackage ¥ Edor | Mapackage v s BHess Y EBHUser ¥ Menooc ™0 7

Access

Access Access Manager Manager

m

oK | [ cancel

Figure 6-9: Sample iCare User Access Management dialog

For those with the appropriate permissions, you can assign roles to a particular user,
scroll to the name on the iCare User Access Maintenance dialog and select the
appropriate check boxes for the roles. If you want to remove an assigned role, de-
select the particular check box.

Note: The BH User column cannot be changed.

Each column heading has hover help.
Some check boxes are checked and the background is dark:

If the user has iCare Package Manager access that supersedes both CMET, Editor and
MU Package Manager permissions. The Employer and BH ones work differently due
to the sensitive nature of the patients involved.

6.5.1.1 Existing RPMS Editor Access

The users displayed on this list (those with the iCare user icon (‘) in first column)
have been given existing Editor or Manager level key(s) to at least one of the
following case management applications: (1) Case Management System (ACM), (2)
Diabetes Management System (BDM), (3) HIV Management System (BKM). (4)
Immunization (BI), (5) Patient Chart Problem List, and/or (6) Women’s Health (BW).
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6.5.1.2 Help Menu
Click the Help menu to view the following information:
The users displayed on this list have been given basic access to the iCare application
by your Site (IT) Manager. You cannot give Editor or Package Manager access to
iCare to a user who doesn’t have basic access. See your Site Manager to require basic
iCare access for other users.
This message applies to the “User with iCare Access” column. Click OK to dismiss
the message.
6.5.1.3 Users with iCare Access
This column is a list of RPMS users who have been given access to the iCare
application by the Site (IT) Manager.
6.5.1.4 iCare Package Manager
The iCare Package Manager has all read/write access as defined for other user levels.
This person can do the following:
e Assign all other access roles in iCare: iCare Package Managers; CMET Package
Managers; Editors; and Taxonomy Editors.
e Access Patient Information associated with Community Alerts.
e Has all read/write access as defined for other user levels.
e Reassign existing iCare panels to iCare users.
Note: Taxonomy Editor Access Management is assigned through
the Taxonomy Maintenance/ Taxonomy User Access
Window from the Tools Menu.
The iCare Package Manager has the highest level of permissions; hence, the iCare
Package Manager will have access to all items accessible by the CMET Package
Manager.
The iCare Package Manager does everything an editor does and also has the ability to
access the list of patients who has triggered the Community Alerts. This person also
assigns Editor access to other users. In addition, this person can assign the CMET
Package Manager role.
6.5.1.5 CMET Package Manager
The CMET Package Manager has the ability to establish the CMET site parameters
related to Tickler Timeframes and Batch Processing. CMET Package Managers have
all read/write access as defined for other user levels.
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6.5.1.6

6.5.1.7

6.5.1.8

6.5.1.9

6.5.1.10

6.5.1.11

6.5.2

Editors

Editors in iCare will have read/write access to: (1) PCC Historical Data Entry; (2)
Care Management data; (3) Family History and Reproductive Factors (Snapshot); (4)
Designated Specialty Provider Management system (DSPM); (5) Problem List; and 6)
CMET Worksheet.

The Editor role will give the person the right to edit the care management function
(e.g., HMS Care Management). It also allows the person to enter Historical Data.

MU Package Manager

The MU Package Manager has the ability to establish site parameters related to the
display of types of Providers on the MU tabs in iCare.

Employer Group Access

Employer Group Access gives the user the ability to define a panel based on the
“Employer” option in Panel Definition. They will also have visibility for the
“Employee Health” option on the Panel View: Care Mgmt tab. Both the definition
and Care Mgmt feature will not be visible to users who do not have permission.

BH Alerts
Exclude non-BH alerts.

BH User
User with existing BH access. This cannot be edited from iCare screens.

IPC Package Manager

The IPC Package Manager has the ability to establish site parameters related to the
background job and microsystem definition for IPC tabs in iCare.

Reassign Panels
The Reassign Panels option displays the Reassign Panels dialog.
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o5 Reassign Panels ﬁ
Reassign From: [N - |
Reassign To: | ﬂ
Panels:

Selec
| ]
! 0K || Cancel

Figure 6-10: Reassign Panels Dialog

This dialog allows the iCare Package Manager to reassign panels from one user to
another user.

Reassign From: select the user from the drop-down list, whose panels you want to
reassign.

Reassign To: select the user from the drop-down list, to whom the panels are to be
reassigned.

Populating the first two fields activates the Select button. Click Select to access the
Add/Remove Panels dialog.

ol Add/Remove Panels @
Available Panels Current Panels
Panel Mame 7 Description v 0.7 * Panel N.. * 7 Description v Owner 7
Pregnant
<< Remove
HIVIAIDS Dx Tag
oKk || cancal |

Figure 6-11: Sample Add/Remove Panels dialog

After the Add/Remove dialog is complete, click OK and the panels listed in the
Current Panels group box will populate the Panels field on the Reassign dialog.
(Otherwise, click Cancel).
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After the Reassign Panels dialog is complete, click OK and the reassigned panels of
the “Reassign From” user are removed from that person’s panel view. The reassigned
panels will appear in the “Reassign To” user panel view. (Otherwise, click Cancel.)

6.6 ICare Taxonomy Editor Function

The iCare Taxonomy Editor holds the security key (BQIZTXED) allowing that
person to read/edit iCare taxonomies.

You access the iCare Taxonomy View/Edit dialog by either selecting Tools |
Taxonomy Maintenance | View/Edit Taxonomy Entries.

o5 iCare Taxonomy View/Edit

NOTE: Site populated taxonomias can only be edited by users with spproprate sccess.

Load Taxonomy ][ Hide Categony ][ Clear Filter(s)

Edit ¥ ltems ¥ Category T Subcategory

Diagnoses

“Lab Tests

Diagnoses

T Name
BEQI RUBELLA CONGEN DXS
| BQI RUBELLA DXS

BQI S PNEUM CULTURE TEST LOINC
BQI S PNEUM CULTURE TEST TAX
BQI S PNEUM SUSCEFT TEST LOINC
BQI S PNEUM SUSCEPT TEST TAX

BQI SALMONELLA DXS
BQI SARS DXS
BQI SHIGA E COLI DXS

Currently Viewing: BQ RUBELLA DXS

* The selected taxonomy is not site editable

ICD-8-CM
ICD-8-CM
ICD-3-CM
ICD-8-CM
1CD-3-CM
ICD-8-CM
ICD-10-CM
ICD-10-CM
ICD-10-CM
ICD-10-CM
ICD-10-CM
ICD-10-C M

Ceding System Code

056.09
056.71
056.79
056.8

0569

647.50
B06.00
B06.01
B06.02
B06.09
B06.81
B0R 83

Description

RUBELLA NERVE COMPL NEC
ARTHRITIS DUE TO RUBELLA
RUBELLA COMPLICATION NEC
RUBELLA COMPLICATION NOS
RUBELLA UNCOMPLICATED
RUBELLA IN PREG-UNSPEC

Rubella with logical compli
Rubella encephalitis
Rubella meningitis

Other neurclogical complications of rubella

Rubella pneumonia
Ruthells srthritiz

NES D

-

m

[ iew Report of All Taxonomies ]

] [ Cancel

Figure 6-12: Sample iCare Taxonomy View/Edit dialog

Note: If you do not hold that security key, you can only view the
information on the dialog. The following information
displays: You do not currently have access rights to edit
taxonomies. In order to edit taxonomy entries, you will
need to have the iCare Taxonomy Editor security key
(BQIZTXED) added to your RPMS user account.

When you first access this view/edit dialog, all parts of the tree structure will be
collapsed. You need to expand one of the tree parts and find the taxonomy you want

to edit.
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6.6.1

In general, select the taxonomy from the list in the left group box that you want to
view. This causes the Add and Remove buttons to appear in the right group box of the
dialog.

Please note that not all taxonomies can be edited. iCare will display a message on the
view/edit dialog when this condition exists. Site populated taxonomies can only be
edited by users with appropriate access.

The difference between the Apply and OK is: the Apply button is used when you add
more than one taxonomy value to the iCare Taxonomy View/Edit dialog.

Add Taxonomy Values

Click the Add button to create values for a selected item in the left group box. The
application displays the Select Taxonomy Item dialog.

Select Taxonomy fhem L&J

Search: || Find...

Select Cancel

Figure 6-13: Select Taxonomy Item dialog

Use the Search field to search for a taxonomy item. Highlight the item you want to
add and click Select. The application checks to see if it is already there.

e [f it already exists, you receive a warning message about that (click OK to
dismiss the message); after clicking OK, you return to the iCare Taxonomy
View/Edit dialog.

e If it does not exist, it appends the selected item to the bottom of the list.

Panel List User Manual iCare Features Used by Panel List

June 2015

38



iCare Population Management GUI (BQI) Version 2.4

After you finish adding taxonomy values, click Apply to “save” your changes. If you
do NOT click Apply and try to move to another taxonomy or another part of the
iCare application, the “Save Taxonomy changes?” information message displays,
asking if you want to apply the changes now. In this case, click Yes to apply the
changes (otherwise, click No).

You can repeat adding items to various taxonomies. When you are finished using the
iCare Taxonomy View/Edit dialog, click OK to save (otherwise, click Cancel).

6.6.2 Remove Taxonomy Values
If you want to remove one or more items from the list, highlight them and click
Remove. The “Confirm taxonomy item remove” message displays. Click Yes to
remove the items (otherwise, click No). You remain on the iCare Taxonomy
View/Edit dialog.
6.6.3  View Report of All Taxonomies Button
Click the View Report of All Taxonomies button to display the Taxonomy Report
pop-up.
=] RPMS iCare - Taxonomy Report E=RRCEN X"
File
g2 A B3 = = |
Find Font Copy Print Preview_—  Print
%% jCare Taxonomy Report *** -
Report Run: Apr 22, 2015 02:43 PM
Wnere Run: 2013 DEMO HOSPITAL
Generated by: NG
Taxonomy Category: COMMONITIES
Name: ACC CHEME VALLEY 2009 Created: Mar 10, 2009
Desc: Modified:
Coding System Code Description
CHEMEHUEVI VALLEY
NELSCHN
Name: ACC PAREKER MARCH 2009 Created: Mar 10, 2009
Desc: Modified:
Coding System Code Description
BIG RIVER
BLYTHE
BOUSE
EARP
| EHRENBERG
Figure 6-14: Taxonomy Report
This pop-up provides information about various Taxonomy Categories (listed in
alphabetical order).
Section 6.7 for information about the File menu and buttons on the pop-up.
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6.7 Pop-up Functionality
Several places in iCare you will be viewing a pop-up. For example, if you double-
click on any row in the Recent Visits group box on the Cover Sheet of the Patient
Record window, you will view a pop-up.
=1o1x|
Ele
¥ A2 " =
Find Fornt Copy Prink Preview... Print...
Patient Name: THETA, ALPHA i‘
Charc #: 344447
Date of Birth: FEB 22, 194<
Sex: M
Visit IEM: 326895
===s===s======== VISIT FILE ====s=s========
VISIT/ADMIT DATESTINE: OCT 24, 1991F12:13
DATE VISIT CREATED: OCT 24, 19591
TYPE: IHS
PATIENT WNAME: THETA, ALPHA
LOC. OF ENCOUNTER: DEHC INDIAN HOSFITAL :[
Figure 6-15: Sample Visit Detail pop-up
You can take the following actions on this pop-up:
e Navigate through the information by using the scroll bar.
')
e Click the Find (Q) button to access a search tool to find data in the current
window. This button works like the Search button.
: Al : .
e Click the Font (|m|) button to display the Font dialog.
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6.8

Font 2 x|

Font: Font style:

|m |F€sgu|a|

() Edwardian Scipt ITC i |Bold
() Eleghant Bod Italic
() Engravers MT
{) Etaz Bold ITC
() Eras Demi ITC s

- Effects | [ Sample
[ Stikeout
™ Under haBbY¥yZz
Script
] |’w’estcm ﬂ

Figure 6-16: Font Dialog

Here you can change the Font name, style, and size of the text in the pop-up (applies
to all of the text). In addition, you can add effects like “Strikeout” and “Underline” -
these perform like those effects indicated in MS Word.

Change the Script option if you need to the see the text displayed in another language
and you have that language pack installed on your computer. If the language pack is
not installed, the display does not change by selecting another script.

Click OK to apply your changes to the text in the current pop-up. These changes are
only effective for the current view of the pop-up. (Otherwise, click Cancel.)

o
e Click the Copy (=) button to copy the selected text to the Windows clipboard.

e Click the Print Preview (_wﬂ:ml) button to view the Print Preview dialog. You
can print the contents of the pop-up from this dialog.

(3
e Click the Print (=) button to display a print dialog where you specify the
printer to output the contents of the pop-up, the page range, and number of copies.

The File menu contains the print actions (like the Print Preview and Print buttons),
the Page Setup function, the find and copy functions, as well as a Close function
(dismisses the pop-up).

Taxonomy User Access

Editing site populated taxonomies can affect many existing processes in RPMS. For
this reason, Taxonomy Edit access is carefully assigned to a limited number of users
and only after discussion with the CRS (GPRA) coordinator.
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Select Tools | Taxonomy Maintenance | Taxonomy User Access to access the
iCare Taxonomy User Access Management dialog.

EE iCare Tamonomy User Access Managemant E‘E‘ﬂ—hj

MNOTE: Edifing sife populafed faxonomies can aifect many exisiing processes in RFWS
For ifws reason, Taxonomy Edifor sccess show'd be carefully assigned fo a fimifed
numbear and only after dscussion with the CRS (GFRA) coordinator af your sife

g}j Help

Existing T : i
RPMS Editor ¥ Users with iCare Access Vo
Access

m

=

4

AUDITING, USER ONE ]
v — = |
@  —
v
I O
v —
| @ —— i
[ ok || cancel |

Figure 6-17: iCare Taxonomy User Access Management for Taxonomy Editor

Each of the column headings has hover help.

6.8.1  Existing RPMS Editor Access
The users with the iCare user icon (\#) in first column are RPMS users with existing
Manager level keys to at least one of the following applications: CRS (BGP),
Diabetes Management (BDM), HIV Management System (BKM), and/or Women’s
Health (BW).
6.8.2  Users with iCare Access
This column is a list of RPMS users who have been given access to the iCare
application by the Site (IT) Manager.
6.8.3  Taxonomy Editor
Those with a checkmark are taxonomy editors who can add and delete members from
any Site Populated Taxonomies related to either laboratory tests or medications.
6.8.4  Help Menu
The following information displays when you click the Help menu:
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6.9

The users displayed on this list have been given basic access to the iCare application
by your Site (IT) Manager. You cannot give Editor or Package Manage access to
iCare to a user who doesn’t have basic access. See your Site Manager to require basic
iCare access for other users.

Change RPMS Server/Login

The Change RPMS Server/Login option appears on the File menu. Select this
option to access the iCare 2.4 Login dialog.

RPMS Server: |TEST7

Access Code: ||

Verify Code: |

[ Usewindows Authentication

0K | Cancel
Description

lUze this panel to enter the Access and Verify codes that you use
to log in to the RPMS server.

Figure 6-18: Sample iCare 2.4 Login dialog
RPMS Server

Click the drop-down list to access the RPMS Server Management dialog that
displays a list of possible connections.

RPMS Server Connection Management IS

Connection | ServesPent | Namespace
Current Connection [... 161.22392251: .. CDAEB

Figure 6-19: Sample RPMS Server Connection Management dialog
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Select an option on the grid or use the New function to create a new connection.

Click New to access the Edit RPMS Server Connection dialog.

Edit RPMS Server Connection =

Connechion Mame: [
[~ Defauk BPMS Server Connection

-APMS Connection Properties

Senver Address/Mame; |

Senver Poat: 0
Sesver Namespace: W Use defaull namespace
[ Usze Windows Suthentication

|
T

Figure 6-20: Edit RPMS Server Connection dialog

Do not select the Default RPMS Server Connection or Use Windows
Authentication check boxes.

Connection Name

Type the name of the connection in this field. This is the name that will appear on the
RPMS Server Connection management dialog.

Server Address/Name

Type the number, including punctuation, of the server’s IP address. An IP address is
typically four groups of two or three numbers, separated by a period (.), e.g.,
161.223.99.999. Your Site Manager will provide this information.

Server Port
Type the number of the server port. Your Site Manager will provide this information.
Server Namespace

If your site has multiple databases on one server, you will additionally need to type
the namespace, which is typically a text string, e.g., DEVEH.

Use default namespace

Select this check box if the Server Namespace is the default one you want to use.
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After completing the fields, the Test Connection button becomes active. Click this
button to access the Test Login dialog. Populate the Access Code and Verify Code
fields and then click OK.

e After clicking OK, if the connection is correct, the application display the
Connection Test message that states: RPMS login was successful. Click OK to
dismiss the message.

e Otherwise, the application will display an error message; click OK to return to the
Test Login dialog.

After the Edit RPMS Server Connection dialog is complete, click OK to have the
server connection appear on the RPMS Server Connection management dialog.
Otherwise, click Cancel.

After the RPMS Server Connection Management dialog is complete, click Save
(otherwise, click Cancel).

After clicking Save, the application displays the login dialog to the application.

6.10 iCare Site Parameter Options
You access the iCare Site Parameters on the Tools menu.
iCare Sike Parameters 3 Employers
Taxonomy Maintenancs 3 Pregnancy
‘Web Links L4 Inactivity Time Ouk
Reset Lisar CMET Ska Paramaters
View iCare Log IPC Site Parameters
ML Sike Paramebers
Divisions
Figure 6-21: iCare Site Parameter options
6.10.1 Employers
Use the Employers option to determine the list of employers that should be used for
employee health. This is a table of all employers in your RPMS system, many of
which can have several different name spellings. Select the Employers option to
access iCare Site Parameters — Employers dialog.
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[ it are Site Parameters - Employers =10 =i

Employpers: AlR FORCE
CHERDOKEE HOSAITAL
Edit | MCOOMALDS/CHEROKEE
THIS IS A TEST

Figure 6-22: Sample iCare Site Parameters — Employers dialog
The current employers are listed in the Employers field.

Use the Edit button to edit the Employers field. Click Edit to access the
Add/Remove Employers dialog.

¥ Adl Remave Employers ﬂ
Available S electons Currend 5elections
Fird Fnd:
ALTO Z0ME AR FORCE
CHERDKEE INDIAN MOSPITAL CHEROKEE HOSPITAL
DEFT OF S0C1AL SERVICES MCOOMALDSCHEROKEE
|FEELDS OF DREAMS Adda> | ITHIS IS A TEST
FIRST AMERICAMN BAMK
IHDOLAN HEAL TH SERVICE ¢ Raweroe |
EMEAAT
RETIRED
ox, Cancel |

Figure 6-23: Sample Add/Remove Employers dialog

When the Add/Remove dialog is complete, click OK and the options in the Current

Selections group box populates the Employers field on the iCare Site Parameters —
Employers dialog. (Otherwise, click Cancel.)

6.10.2 Pregnancy

Use the Pregnancy option to determine the definition of pregnancy by a choice of two
methods for calculation. Select the Pregnancy option to access the iCare Site
Parameters — Pregnancy dialog.
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6.10.3

~ioix]
~ Pregnancy
Type: [iCare =
Time Frame: |3 morthe =

Figure 6-24: Sample iCare Site Parameters — Pregnancy dialog

Type

The default method is based on CDC influenza disease-reporting (IL1) logic where
pregnancy has to be medically indicated in the last 60 days. Select an option from the
drop-down list to populate the Type field. If the “ILI” is selected, then the Time
Frame field does not appear on the dialog.

Time Frame

The second method of calculation is iCare-specific and can be set to where pregnancy
has been medically indicated in the last 1-month to 9-month time period. Select an
option from the drop-down list to populate the Time Frame field.

When the dialog is complete, click Save to save the pregnancy parameters.
(Otherwise, click Cancel.)

Inactivity Time Out

iCare incorporates time out features to ensure secure usage in clinical community
workstation environments. Use the Inactivity Time Out option to determine the
inactivity time out, inactivity warning message time out, and application shutdown
time out.

Select the Inactivity Time Out option to access the iCare Site Parameters —
Inactivity Time Out dialog.

Panel List User Manual iCare Features Used by Panel List

June 2015

47



iCare Population Management GUI (BQI) Version 2.4

[ iCare Site Parameters - Inactivity Time Out ==

 Inactivity Time Out

Inactoaty Tiene Ot [in minutes]

Apphication Shutdown Time Dut fin minutes)

e
Inactivity W aming Message Time Out (in seconds] EE
IEﬂ - I

Figure 6-25: Sample iCare Site Parameters — Inactivity Time Out dialog

Inactivity Time Out

Select an option from the drop-down list that determines the number of minutes
before the application locks the application from further use by the current user.
Inactivity Warning Message Time Out

Select an option from the drop-down list that determine the number of seconds before
the Inactivity Warning Message displays.

Application Shutdown Time Out (in minutes)

Select an option from the drop-down list that determines the number of minutes
before the application will shutdown.

6.10.4 CMET Site Parameters

Use the CMET Site Parameters option to determine the tickler timeframes and batch
processing for CMET. Select the CMET Site Parameters option to access the
RPMS iCare — CMET Site Parameters window.
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a5l RPMS iCare - CMET Site Parameters L—J

Tickler Timeframes are sef for the sife, nof the individual user. Consigerafion for these fimeframes show'd be besed on fupical (or
average) lengths of fime if would fake fo receive resulfs, consider next sfeps. and nobify patiants.

LastEdited By
Finding Ticklers m After the date of the Event
Follow-up Decision Ticklersm After the date the Findings were entered
Patient Motification Ticklers ,m After the date the Follow-up

Version 2.4

recommendation was entered

[ oK ]| Cancel |

Figure 6-26: Sample RPMS iCare — CMET Site Parameters dialog

Tickler Timeframes

The Tickler Timeframes tab sets the ticklers (like reminder notices) for Findings,
Follow-up Decision, and Patient Notification.

Each field has a drop-down list from which to select an option. When a timeframe
date is passed and the step has not been entered, the Tickler will be displayed.

After you change one or more settings and click OK and the application populates the
Last Edited field with the date, and the By field with the person who changed the
tickler timeframe data. (Otherwise, click Cancel.)

The application provides Ticklers designed to remind the user that a CMET is tracked
and requires attention. There are three types of Ticklers:

Finding Ticklers, based on the event date. The Tickler is initiated from the date of
the event.

Follow-up Decision Ticklers. Ticklers are initiated from the date the Findings
were entered.

Patient Notification Tickers. Ticklers are initiated from the date the Follow-up
recommendation is entered.

Timeframes for each of the three steps is based on the preceding step. For example, a
Follow-up Decision Tickler is based on the date the Finding was entered.
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6.10.5

Batch Processing Tab

The Batch Processing tab sets the timeframe and notification type for the Pap Smear
and Mammogram Screening events with normal results. In addition, you can set the
type of Normal Finding for the Mammogram Screening event.

ot RPMS iCare - CMET Site Parameters &J

Tickler Timeframes .~ i Bs

Baich Processing can be done for mulfiple patients with "Nommal” results for Pap Smears or Screening Mammograms. Select the
Findings: Timaframe (follow-up infanval): and Notification Types that will ba anfared whan parforming CMET Bafch Processing

Event Name Timeframe Notificaiion Type LastEdited By

Pap Smear |‘I'_.'ear ﬂ |LE'I'I'ER ﬂ

Mammogram Screening [2years | [LETTER ~| enoeos [
Normal Finding for Mammogram Screening
|BI-RAD CATEGORY 1- NEGATIVE |

oK ]| Cancel |

Figure 6-27: Sample Batch Processing tab

The Notification Type field defines how the patient will be notified about the Pap
Smear or Mammogram Screening, for example, by telephone. The default is
LETTER.

The Timeframe consideration is based on typical (or average) length of time it would
take to receive results, to consider the next steps, and to notify the patient.

The option selected for the Normal Finding for Mammogram Screening field
determine what is a “normal” finding.

Each field has a drop-down list from which to select an option.

After you change one or more settings and click OK and the application populates the
Last Edited field with the date, and the By field with the person who changed the
batch processing data. (Otherwise, click Cancel.)

IPC Site Parameters

Use the IPC Site Parameters option to determine the following IPC parameters: (1)
day of month to run IPC data collection, (2) clinics where the patient receives primary
care, and (3) microsystem providers.
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EH iCare Site Parameters - IPC [ =l | =] |_ihl

IPC

The IPC measures are aggregated each month and displayed
on the Provider Aggregated and Facility Aggregated tabs. Data
entered by EHR/PCC/Coding/Billing after the data collection
has occurred will not show up on the monthly reparts. Sites
should factor in the PCC/Coding lag time when setting this
parameter. Example: f your site has a 2 day delay in data
entry, run the |IPC data collection on the 3rd night of the month.

Day of the month to run |PC data collechon: 3 -

This is a list of clinics that are considered as primary care
clinics for the Continuity of Care to 3 Primary Care Provider
measure. 1hese clinics will be included in the numerator of the
Continuity of Care to a Primary Provider measure. Refer to the
|IPC Measures Guide for guidance.

Clinics where the patient receives pnmary care I

13 7]
FAMILY PRACTICE (28)
GENERAL {01}
GENERAL PREVENTIVE {27)
GYNECOLOGY (10) .

Flease select Designated Primary Care Provider(s) who are
included in the IPC microsystem

Microsystem Providers

s

| | cancel

Figure 6-28: Sample iCare Site Parameters — IPC dialog

Day of month to run IPC data collection

Select from the drop-down list the option that specifies the day of the month on which
to run the iCare IPC data collection.

Clinics where the patient receives primary care

This field determines the type of local clinics to be designated as primary care. Click
Edit to access the Add/Remove Visit Clinics dialog.
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[ AddRemovevisit Cindes x
Availsble S elections Cunent Selections
Firuk Find:
ALCOHOL M0 SUBSTANCE [43) = FAMILY PRACTICE (22
AMBLILANCE [A7) BEMERAL |01
AMESTHESIOLOGY (D) INTERMAL MEDICINE [13]
AMTICOAGULATION THERARY D) Add v PEDLATRIC [20)
ALDIDLOGY [35]
BEHAVIORAL HEALTH [C4) ¢ Rnmove |

CANCER CHEMDTHERAPY [62)

CAMCER SCREEHING (58]

CARDIDLDGY [02)

CASE MAMAGEMENT SERVICES [77)

CAST RODM [55)

CHART REV/REL MOD [52) =l

oK Concel |

Figure 6-29: Sample Add/Remove Visit Clinics dialog

When the Add/Remove dialog is complete, click OK and the options in the Current
Selections group box populates the “Clinics where the patient receives primary care”
field.

Microsystem Providers

This field determines the names of specific providers that can be included by users in
the site’s microsystem(s). Click the Edit button to access the Add/Remove DPCPs

dialog.
nf Add/Remove DPCPs &J
Available Selections Current Selections
Find: Find:

* Starts With  Contains

m

[ ok ][ cance

Figure 6-30: Sample Add/Remove DPCPs dialog

When the Add/Remove dialog is complete, click OK and the options in the Current
Selections group box populates the Microsystem Providers field. (Otherwise, click
Cancel.)
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6.10.6 MU Site Parameters
Use the MU Site Parameters option to determine the Meaningful Use site parameters
based on the following: (1) providers based on ORES key, (2) performance, and (3)
clinical quality. Select the MU Site Parameters option to access the Meaningful Use
Site Parameters dialog.
. o5l Mezningful Use Site Parameters = | & =
Providers based on ORES key NOTE:
Providers: - !Ph)ysician} 1. If Provider is not assigned a User Class/Type in
e, ] Iiglwaaﬁ RPMS. their data will not display in the MU tabs.
&I E@[Num}e Practitioner) 2. Provider Clinical Quality measure searches may
I (Fysiciai) take 1-3 hours per provider. Therefore. fewer
I '-PI";‘?'_'E::;;';)H} providers listed in the Current Selections list shawn
e o ted in Sl 16 200 providers Chinges o tho.
list will be visible upon completion of the next
Weekly background job.
Performance Clinical Quality
Default for Perfarmance: |1 Marith j Default for Clinical Quality (CQ): |1 Marith j
Current Performance: |INTERIM STAGE 1 2014 j
Provider Performance can be further filtered to only
include the following User Types
Show Types? i~
User Types: Clinical Coordinator
Nursn_a _Plac:t'rliuner
Cem ] [P
Save Cancel
Figure 6-31: Sample Meaningful User Site Parameters dialog
When the Meaningful User Site Parameters dialog is complete, click Save to save
the MU site parameters. (Otherwise, click Cancel.)
Providers based on ORES key
The Providers field contains the list of Providers that is listed on the PM — By
Providers, CQM - Providers, and CQM - Providers Reports sub-tabs (of Meaningful
Use). Click Edit to access the Add/Remove Meaningful Use Providers dialog.
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ol Add/Remove Mezningful Use Providers &J
Available Selections Current Selections
Find: Find:

(* Starts With ¢ Contains

DEMO.DOCTOR (Physician) ~

{Physician)

{Medical Clerk) &

[ ok ][ GCancel

Figure 6-32: Sample Add/Remove Meaningful Use Providers dialog

When the Add/Remove dialog is complete, click OK and the names in the Current
Selections group box populate the Providers field for the Providers Based on
ORES key group box. (Otherwise, click Cancel.)

Performance group box

Use the Performance group box to set the default timeframes for displaying MU
performance and CQM measures data.

Default for Performance

Select an option from the drop-down list to determine the default timeframe.
Current Performance

Select an option from the drop-down list determines the current performance stage.
Show Types?

Select this check box to display the “Type” column on the PM — By Provider sub-tab
of the MU window.

User Types

This field contains the user classes for the performance measures. Click Edit to
access the Add/Remove User Classes dialog.
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B Add Remove User Classes = ﬂ
Avvail sble S electons Curment S elections
Fimd: I Find:

Al g - Huspe Prachbone
Aloigy & Immanoioges Flepzician
e at Addss Prepsicean fismistan
mﬁmm&: 0 Stalt e
mCian
duachologiit 44 Ramove
| Eleburiceal Health
(Cancholopist
Chaplan
Chéed Rasidert
Chied, Mieschcal Senace
Cheed, MIS |

of. Corcel |

Figure 6-33: Sample Add/Remove User Classes dialog

When the Add/Remove dialog is complete, click OK and the options in the Current
Selections group box will populate the User Types field in the Performance group
box. (Otherwise, click Cancel.)

Clinical Quality
Select an option from the drop-down list that determine the default clinical quality
time for the Clinical Quality measure searches.

6.10.7 Divisions

Use the Divisions option to determine the divisions for your site. Select the Divisions
option to access the iCare Site Parameters — Divisions dialog.

[# iCare Site Parameters - Divisions i =10| x|

Figure 6-34: Sample iCare Site Parameters — Divisions dialog

The listed divisions are those used by your site. Click Edit to access the
Add/Remove Divisions dialog.
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Figure 6-35: Sample Add/Remove Divisions dialog

When the Add/Remove dialog is complete, click OK and the options in the
Current Selections group box will populate the Divisions field on the iCare Site
Parameters — Divisions dialog. (Otherwise, click Cancel.)

6.11 Manage Templates

The Manage Templates option provides a means for defining multiple template
layouts. Templates can also be created and added so that anyone can download and
use them.

The Manage Templates option appears on the Tools menu. Select it to access the
Template Management dialog.

okl Template Management

Your Templates

Layout TR Template 7 Last Edited T Canbe deleted? 74 ot
p Care Mgmt - Asthma Asthma Default 07/02/2014 E
Definition Details - Allergi llergies Default 07/02/2014
Care Mgmt - Dizbetes Dizbetes Default 07/022014 Delete
Care Mgmt- COPD COPD Default 07/02/2014 =
Definition Details - CPTs CPTs Default 07/02/2014 Edit I
Patient List Patient Default 07/02/2014 Upload
Definition Details - Pt Pt Education Default 07/02/2014
Education i

Public Templates

g‘: Pl|s !
2 |a| 2 &2 @

Layout TR Template TR Author TR LastEdited 7+ Uploaded T8 ‘s

Definition Details - Allergi NIST All 10152013 10152013 = Delete
Definition Details - CFTs NIST CPT 10152013 101152013

Definition Details - ER Visits MSIT ER 10152013 10152013

Definition Details - Inpati MIST Inpati 10152013 10152013

Definition Details - Lab Tests  NIST Lab 10152013 1015/2013

Definition Details - Medicati NIST Medicati 10152013 1015/2013

Definition Details - Problems MIST Problems 10152013 10152013

Nafinition Natzils - P MIST Bt e NARANTT NARAND

Figure 6-36: Sample Template Management dialog

The Your Templates group box contains a list of all of a specific user’s defined
templates and the layout contained in each template.
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6.11.1

6.11.2

6.11.3

6.11.4

6.11.5

6.11.6

The Public Templates group box contains a list of all templates at the site that are
available to be downloaded to the list in Your Templates.

View
Use the View action to view a selected template. This is a view-only display.

Upload

The Upload action is available in the Your Template group box. Select a template to
upload and then click Upload. The selected template will appear in the Public
Templates group box. The author will be you (the person who executed the Upload).

Download

The Download action is available in the Public Templates group box. Select a record
to download and then click Download. The selected template will appear in the Your
Templates group box. In the Template field, your name (the person who executed the
Download) will appear after the name of the template.

Delete

The Delete action is available in the Your Templates and Public Templates group
boxes and applies to your templates only. Select a record to delete and then click
Delete. The Delete Template information message display confirming the deletion.
Click Yes to delete (otherwise, click No.)

Edit

The Edit action is available in the Your Templates group box. Select a template to
edit and then click Edit. You access the template of columns for the selected
template. Section 6.11.6.1 provides information about how to use this template.

Add

The Add action is available in the Your Templates group box. Click Add to access
the Add Template dialog.
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[ Add Template =10 x|

Lo | g

Figure 6-37: Add Template dialog

Layout: Select an option on the Layout drop-down list to specify the layout to be
used for the new template.

After populating the Layout field, the Template Name field appears.

_iolx]

Definstion Details - ER Visks

Template Mame i imted to 80 characters and must contain &t least 1 alpha character.

Template Name: |
Add Exit

Figure 6-38: Add Template dialog with added field

Template Name: Type the name of the template in this Free Text field, limited to 80
characters and must contain at least 1 alpha character.

After the dialog is complete, click Add to access the template to define the columns
and their sorts for your new template. (Otherwise, click Exit.)
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Figure 6-39: Sample template for new template created

Click the Reset to System Default button to cause the template to reset to the system
default.

If you changed several things about the columns on the template and you want to
“undo” those changes, click Reset.

After the template window is complete, click OK and the “new” template will appear
in the Your Templates group box. (Otherwise, click Cancel.)

6.11.6.1 Display and Available Columns

Use the Display Columns to determine what columns you want to display for the
particular window or tab.
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Figure 6-40: Sample Display and Available columns

The listing in the Display Columns area shows the columns that will be displayed for
your template. The column names in italics are required and cannot not be removed.

To move a highlighted column name in the Available Columns area to the list in the
Display Columns area, click Add. This moves the column name from the left panel
to right panel.

Likewise, you can remove a highlighted column name in the Display Columns area
and move it to the Available Columns area by clicking Remove. This moves the
column name from the right panel to the left panel.

Note: You cannot remove any column names in italics.

You can determine the order the columns display in the Display Columns area by
using the Up and Down buttons. Highlight a column name and click the appropriate
button. You might have to click the button more than once to move it to the desired
location.

6.11.6.2 Columns to Sort
Sorting a column means you want to arrange the items in the column in alpha-
numeric order.
Avalable Sodx Saont Coburmna:
: ”Efmw Ay I Piatiarst Mama ASC g
A 4 Fepmcren I [15.]
Swahch G
Diechion
I:Iluﬁem[ru
Atres D0 Tagn
[rempnated PP
Figure 6-41: Sample Available Sorts and Sort Columns area
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6.11.6.3

6.11.6.4

To move a highlighted column name in the Available Sorts area to the list in the Sort
Columns area, click Add. This moves the column name from the left panel to right
panel.

Likewise, you can remove a highlighted column in the Sort Columns area and move
it to the Available Sorts area by clicking Remove. This moves the column name
from the right panel to the left panel.

Note: You cannot remove any column names in italics.

Column Sort Order

You use the Sort Columns area to determine what columns you want to sort for the
particular window or tab.

You determine which order the columns are sorted in the Sort Columns area by
using the Up and Down buttons. Highlight a column name and click the appropriate
button. You might have to click the button more than once to move it to the desired
location. For example, if you have Gender, Patient Name, and Diagnosis Tags in the
right column, the Gender sort is applied first then the Patient Name and then the
Diagnosis Tags is last.

Switch Sort Direction

The names of columns in the Sort Columns area show “ASC” appended to the name,
for example Patient Name ASC. You can switch the sort order for a selected column
by clicking the Switch Sort Direction button. In the example, the name changes to
Patient Name DESC. You can use the “switch sort direction” action on more than one
column.
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Glossary

Context Menu
The menu of options that displays when you right-click on an entity.

Designated Primary Care Provider (DPCP)

In RPMS, the provider name that is assigned as the primary care physician for
a patient or group of patients at a specific facility. This is not a required
function.

Free Text Field
A field where the user can type text, just like typing a note to someone.

iCare Package Manager

The designated person with authority to manage all information settings for
iCare.

Panel List
The list of patient panels owned by the user.

Providers

Any staff member in an 1/T/U facility who provides direct healthcare to
patients, e.g. general practice or specialty physicians, registered nurses, social
workers, physician assistants, etc.

Taxonomy

In RPMS, a grouping of functionally related data elements, such as ICD
codes, that are created and maintained within the RPMS Taxonomy Setup
application. Taxonomies will be used as definitions for diagnoses, procedures,
lab tests, medications, and other clinical data types.

If you need a change or addition to an existing taxonomy, please see your
CRS coordinator.

Tooltip/Hover Help
A common GUI element used to provide additional information to users. To
display a Tooltip, hover the mouse pointer, without clicking, over a column
heading or field.
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Version 2.4

Acronym List

Acronym Term Meaning

BQI Namespace for iCare

CcQM Clinical Quality Measures

GUI Graphical User Interface

HHS Health and Human Services

IHS Indian Health Service

IPC Improving Patient Care

MU Meaningful Use

oIT Office of Information Technology
PM Performance Measures

RPMS Resource and Patient Management System
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Contact Information

If you have any questions or comments regarding this distribution, please contact the
OIT Help Desk (IHS).

Phone: (888) 830-7280 (toll free)
Web:  http://www.ihs.gov/helpdesk/
Email: support@ihs.gov
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